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San José State University
f Liberal Arts, Department of English and Comparative Literature

ENGL 131, Section 1 (23419), Spring 2020 — Poetry Writing

Basic Course and Contact Information

Instructor: Dr. Michael Tod Edgerton /EDJ-er-tun/

Preferred pronouns: He/him/his

Office Location: Faculty Office Building (FOB) 223

Telephone: 408-924-4069

Email: Michael. Edgerton@sjsu.edu (email is my preferred mode of communication)
Office Hours: Mondays and Wednesdays 1:30pm — 2:45pm and by appointment

Class Days/Time: Mondays and Wednesdays 12:00pm — 1:15pm

Classroom: Clark 238

Prerequisites: ENGL 1A and ENGL 71 (if you do not meet this requirement, you need

to see me after the first class for permission to stay in the course)

Course Description

Workshop in verse forms. Study of traditional and contemporary models. May be repeated twice for
credit. Prerequisite: ENGL 71 (or equivalent) or instructor consent.

Course Learning Outcomes (CLO)

This course addresses the following Student Learning Objectives (SLOs) approved for the BA in
English. Upon successful completion of this course, students will be able to:

» SLO #1: Read closely in a variety of forms, styles, structures, and modes, and articulate
the value of close reading in the study of literature, creative writing, or rhetoric.

* SLO #3: Write clearly, effectively, and creatively, and adjust writing style appropriately
to the content, the context, and nature of the subject.

Required Texts and Equipment
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Tyehimba Jess, Olio.
Wave Books, 2016.
ISBN-10: 1940696208
ISBN-13: 978-1940696201
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= Robert Pinsky, The Sounds of Poetry: A Brief Guide.
Farrar, Straus, and Giroux, 1999.

ISBN-10: 0374526176

ISBN-13: 978-0374526177

Matthew Zapruder, Why Poetry.
M Ecco, 2018.

7 ISBN-10: 0062343084
g_n—ﬂ-nv ISBN-13: 978-0062343086

MATTHEW ZAPRUDER
ANTBSR & cone B ALL YW GRUSTS

Other readings will be posted to Canvas as PDF files. You must have the free Adobe Reader, which you
can download from https://get.adobe.com/reader, or the even better Adobe Acrobat Pro DC, which you
can also download for free from SJSU’s Software Downloads site at
http://www.sjsu.edu/it/services/collaboration/software/instructions.php.

Technology Requirements (ves, requirements—these are not suggestions)

Laptop or tablet computer. Bring one to every class, with your power cord. You can check out laptops
from the 4" floor of the MLK library if you need to (but be sure to return them on time—they charge a
$20 per day late fee!).

Microsoft Word, which you can download free as part of the entire MS Office suite at
https://www.microsoft.com/en-us/education/products/office. All your writing assignments need to be in
“.docx” format, including your critiques of peer writing. (You can also use Google docs or Open Office,
using “save as” to reformat your assignments, but I will only accept submissions of assignments in MS
Word (.docx) format, and it is much easier to just keep everything in Word.)

Adobe Reader. Download it free from Adobe.com: https://get.adobe.com/reader.

Drop Box Account. You can sign up for a free account and download Drop Box online at
https://www.dropbox.com, This will allow you to save your work for this class both on your hard drive
and online, as, when you’re connected to the Internet, Drop Box automatically saves your files to the
cloud. You should create an ENGL 1A file on your computer and in the cloud using your free Drop Box
account. This way, you can access your work from any computer with internet access or from your own
computer, with or without internet.

Course Format

This is a “flipped” course, run mostly as a discussion seminar. This puts you in the driver’s seat as the
primary agent of your own education (as is always truly the case, if differently, even in a traditional
lecture course). You are responsible for coming to each and every class fully equipped with your
reading and writing device, having fully prepared for class (see more below). Approved devices
include laptop and tablet computers only; phones will not be permitted.

A lot of our readings will be PDF files and online texts made available on our Canvas course site
(go to the Canvas log-in at http://sjsu.instructure.com, or go through your SJISU “One” resource page at
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https://one.sjsu.edu), so you will need to bring your computer—and power cord—to every class. If

you do not own a computer, it crashes, or you leave it at home one day, you can check out a laptop from
the M. L. King Library, on the fourth floor, right off the elevator.

NOTE on 4-unit requirements. Because this is a 4-unit course, students can expect to spend a
minimum of twelve hours per week preparing for and attending classes and completing course
assignments. This means that this course is especially reading- and writing-intensive and, as such,
requires more work than a regular, 3-unit course. This entails model poetry readings, readings on
prosody and poetics, readings and critiques of student writing, weekly writing of new poems, and
weekly revisions of previously written poems.

This fourth-unit enhancement to the course entails, specifically:

1. A weekly Reading Journal, where you will closely analyze a poem every week (in addition to
doing the same for your peers’ poems), chosen from among those that have been assigned and,
on specifically designated weeks, from contemporary literary journals (see Canvas for a list).

2. A weekly, ongoing Writing and Revision Journal. This will consist—each week—in at least
two of the following three different writing assignments:

a. Optional, but recommended. The generation of New Raw Material, in poem or prose
form, lists of observations, possible lines/potential titles, etc.

b. Required: A brand New Poem. This poem is the writing assignment I will give you,
but those assignments will vary a great deal, from the precisely specific (e.g., a ghazal
in the traditional form, including with a direct or indirect reference to your own name)
to the completely open.

c. Optional. A Revised Poem. This should be a substantive revision of a previously
turned in “New Poem,” not just an arbitrary change of a couple of words for synonyms
or the cleaning up of grammar and punctuation that you should have done before you
posted it the first time in the category of “New Poem” (although you should certainly
clean up any mistakes your first round of proofreading missed). But in “substantive” I
am looking for quality, not necessarily quantity of revisions (and certainly some poems
you’ll revise more than others). These revisions can include further development of
the concerns, questions, associational/metaphorical “trails” that first led you down this
particular poem’s path, it’s narrative, dramatic, philosophical, emotional, sensory,
political elements (i.e., its content) and/or the specific imagery/description, tone and
diction, sound patterning and play of the poem, lineation, page “choreography,” etc.
(i.e., its “form”), and may indeed include several of these.

Important Note on Revisions

Be sure to version these out so you can keep track of all your changes by saving them as
differently titled documents. For instance, you might have a poem in a document you simply title,
“Writing Assignment 1.” When you revise it, you’ll hit “Save As” and title it “Writing
Assignment 1 v.2” (and then “v.3, v.4, and so on). You may find at times that you want to bring
back an earlier choice that you’ve deleted—don’t lose it by failing to version out your revisions.

You will find each of these assignments, Reading Journal and Writing Journal, posted to Canvas
each week with any specific assignment instructions for your new poem to write or which poem
(or, more often than not, which set of poems to choose a poem from) to read closely (“literally,” to
use Matthew Zapruder’s word).
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Class Preparation

This course requires a great deal of reading and writing. As I write above, you are responsible for coming
to every class fully prepared to participate in all activities. Active participation and extensive
preparation are both key to your success in this course. This will entail:

1) Carefully reading and following all assignment instructions on Canvas. If you have questions, re-
read the instructions. If you are still unclear, ask me in class or email me at
Michael.Edgerton@sjsu.edu.

2) Reading and preparing to discuss all assigned materials for a specific course meeting.

To fully prepare a reading for class, you must:

A) Read carefully and attentively 100% of the assigned material.

B) Highlight or underline key passages. It is especially helpful to note points in the text about
which you are confused or have a question, bringing these passages up in class for us to think
about together.

C) Write a summary and interpretation for the reading. Break down how it uses the techniques it
employs to create the meaning and reading experience it does. How does it shape your
experience as a reader, leading you to feel and think certain things? Think about how you
might use such techniques in your own writing, and how your choices as a writer shapes the
reader’s experience of the text. These analyses will be posted to Canvas and checked for
completion.

e Your textual analysis assignments from item “C” above are each to be written in a separate MS Word
doc and uploaded to the corresponding reading assignment on Canvas, the same one from which you
download the PDFs and on which you'll find the prompt for those readings.

e Textual analyses should generally be about 1-3 pages of double-spaced prose in Times New Roman
12-point font or equivalent. I’'m not interested in policing exact word count, but in seeing you earnestly
engage the readings to interpret them, to understand how they’re using various strategies and
techniques to produce the effects they have on readers (and so serving as a possible model for your
own writing), and to make connections with other texts we’ve read.

e Where I perceive a lack of effort, I will grade accordingly, but in general I grade these reading
responses for completion, not how “correct” I think your analysis is.

Course Materials and Communications

As noted above, course materials such as syllabus, readings and handouts, notes, assignment instructions,
etc. can be found on our Canvas Learning Management System course website, which you can access
directly at http://sjsu.instructure.com and through your OneSJSU page (https://one.sjsu.edu).

You are responsible for regularly checking with the messaging system in Canvas and your
SJSU email account on a daily basis for communications from your professors and the university.
Always email your professors and other university staff from your SISU account and not from your
personal email.

The exception to the above rule will be student writing offered for workshop. We will use a class
Google Drive for uploading both student pieces to be workshopped and the class’ analyses of how those
pieces are working.
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Course Requirements and Assienments

The University Policy S16-9, Course Syllabi (http://www.sjsu.edu/senate/docs/S16-9.pdf) requires the
following language to be included in the syllabus:

“Success in this course is based on the expectation that students will spend, for each unit of credit, a
minimum of 45 hours over the length of the course (normally three hours per unit per week) for
instruction, preparation/studying, or course related activities, including but not limited to internships, labs,
and clinical practica. Other course structures will have equivalent workload expectations as described in
the syllabus.”

Final Portfolio

At the very end of the semester, you will submit, in a single Word document (.docx) of revised writing
from your writing assignments throughout the semester (see “Note on Revisions” below). More specific
guidelines are given on page 8 of this syllabus and will be copied on Canvas at the end of the semester.

Grading Policy

Final Grade Breakdown

e Weekly textual analyses of model readings: 25%

¢ Final Portfolio of Revised Creative Work: 40%

e In-class workshops/written critiques: 25% (this includes both submitting and being present for
your own workshop and submitting written workshop analyses of others’ pieces)

e Participation in reading and workshop discussions: 10%

Determination of Grades

Grades will be allocated according to the amount of work you put into the class. While talent will Grades
will be allocated according to the amount of work you put into the class. While talent will rewarded, as
this is an undergraduate writing course, I do not expect anyone to be writing publishable quality work
(though you may very well be already). In order for you to feel free to “Try Again. Fail again. Fail better,’
as Samuel Beckett characterized the artistic process. I am not going to grade the quality of your individual
pieces. Instead, you will receive credit for completion. The most important thing I try to teach my creative
writing students is permission, to give yourself the permission to try anything, to push the proverbial
envelope, to experiment and fail, which is never failure, so long as you learn from it and keep writing.
Engaging in a sustained writing practice itself is success. In the end, what I will grade your Final
Portfolios and final grades on will be relative quality (compared both to other students and, primarily, to
yourself, rewarding improvement) and hard work (as evidenced by completion of all reading and writing,
discussion and workshopping assignments and by revisions turned in as part of your Final Portfolio). That
breakdown will be roughly 40% quality of final poems and 60% effort put into them (and overall) over
the semester.

b

IMPORTANT NOTES:

No extra credit will be given in this class.
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Missed in-class or late work will only be accepted at the discretion of the instructor. If accepted, a penalty
of up to 10 percentage points per day late may be assessed.

Classroom Protocol

PARTICIPATION is required from all students—there is no room for wallflowers in this class. If
you’re a shy student, take this course as a challenge and opportunity to build your confidence and public-
speaking skills. We all say something “wrong” or that makes us feel “stupid” sometimes—so what? It’s
not the end of the world. It’s often, in fact, how we learn, and we are all learning and developing as
readers and writers together. We will work collaboratively, helping one another to improve our skills. We
will not judge but support one another, even as we debate controversial issues, evaluate one another’s
performances, and critique one another’s arguments—all for our mutual betterment.

This class is not a lecture but a seminar, and I will be facilitating your discussions of readings and student
writing. Your physical and mental presence is therefore expected at each and every class meeting. This is
not the kind of class you can miss and just get the lecture notes from a friend to catch up. Every class will
require your active participation. A writing course is a community of learners undergoing a process
whereby they develop their reading and writing skills over time, through hard work and dedication.
Writing courses are by their nature time- and energy-intensive courses. Staying on track with homework
assignments and being present (both physically and mentally) and actively contributing to class
discussions and completing in-class writing or other assignments is absolutely essential to your success in
this course.

You are therefore expected to arrive on time, fully-prepared, and ready to participate actively in
each class meeting. To receive credit for contributions to discussions, you must offer new insights or
pose questions that lead to productive conversation, not just repeat what someone else has said. This
also means that you must come to class with all required assignments completed and reading and writing
homework materials in hand (be that as a print-out or on your computer). Missed and late assignments
will not be accepted and make-up work or extra credit will not be given (or only at my discretion,
and may incur a grade penalty, as outlined in “Grading Policies”).

Discussion Guidelines

e Be RESPECTFUL (almost every other guideline is a subcategory of this all-important one!)

e No yelling, talking over, interrupting, or—obviously—no personal insults.

e Try to understand and be considerate of others’ perspectives, opinions, and feelings

e Come prepared so you can actively and substantively contribute to discussion (and not waste your
classmates’ time B.S.-ing). Read and write your assigned analyses/responses and bring those to
class along with the reading so you have all of your materials, notes, and ideas at hand.

e Speaking of wasting others’ time, don’t just repeat what someone else already said. You can
certainly extend it, offer a different perspective on it, etc., but don’t just repackage it in different
words and hope we don’t notice.

e Let others speak. We don’t want class to devolve into a situation where the same five people carry
the conversation all the time. The popcorn method was a good suggestion for doing this, too
(although “hot potato” and “tag” seem like more accurate analogies to me...but whatevs). It’s
where one student starts out with a contribution and then randomly passes the discussion baton on
to another person.
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e To that end, BE COGNIZANT of yourself and of others. Always be “taking the temperature” of
the room, and give others space to speak.

e And to that end: Don’t Be Afraid of Silence. Sometimes a minute or two of silence gives more
tentative people time to step up.

e Offer CONSTRUCTIVE critique. While our goal is to discuss, debate, and rigorously evaluate
one another’s reading and writing to help one another improve throughout the semester, we want
to do this in as supportive, encouraging, and positive a manner as we can.

e Conversely, be open to criticism. It’s the only way to learn, and becoming defensive can just shut
out what others have to have offer you. We’re not going to judge one another, but help everyone
improve as much as we can.

e Stay on topic. Tangents are usually counterproductive.

e ACTIVELY LISTEN AND PARTICIPATE in discussions, don’t zone out, drift off or get up and
leave in the middle of class (use the bathroom beforehand). If you’re going to be sick, of course,
by all means run!

e Be CONFIDENT in your presentations of your analyses, interpretations, evaluations and critiques.
It’s fine to admit wen you know you’re going out on a limb, taking a stab in the dark, but if you
feel you have a strong case to make for the strength or weakness of an argument or its evidence,
for example, don’t be afraid to say—and stand by—it. Even if you don’t always feel that way, try
to hold yourself with confidence—fake it ‘til you make it! (Arrogance is something altogether
different, and we want to avoid it.)

e The first step in gaining confidence in your ideas is to always ground them in the language, logic,
and evidence of the text itself, in what’s actually on the page. Not all interpretations are equally
valid—or valid at all. Although I always welcome going out on a limb when faced with a difficult
text (again, trying and “failing” is never failure), try to be aware of your own cognition as you
read, and of where you might be projecting something onto the text where there’s no real basis for
it in the language used.

Workshop Procedures

Rule number one: as with discussions of model readings, remain respectful, but honest. Our main goals
are to communicate our full sensory, emotional, and intellectual experience of the work, to
articulate what we see the piece’s aims being (which may or may not line up with the author’s actual
intentions—and so good for her to know), and to constructively critique how well the work is meeting
those goals, perhaps offering alternative possibilities for various artistic choices, from wording to
imagery, narrative strategies, characterization, such poetic structures as line and stanza breaks, etc. What
does the piece do to us and how does it do it?

If your piece is being workshopped, you can inform us ahead of time if you want your piece approached
with certain questions or concerns, just add a prefatory note in the Word/PDF document itself before the
title of the piece (I’d put it on its own page). Always include your name inside the file and as part of the
file name: “JaneDoe-TitleofPiece,” for instance.

Here are some specific questions and concerns to consider when reading your peers’ work and
model readings alike:

1. What effects does this piece produce in you (ideas, emotions, questions, appreciation of style, etc.)
Another way of putting it: What are the aims of this piece? These may or may not be the conscious
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intentions of the writer—we can’t read their minds, so we can only be concerned with what we think the
poem or story is aiming at, regardless of the writer’s intentions. The writer will have to decide for herself
whether to attend to any discrepancies or embrace a new reading and new aim for her work, perhaps
revising towards this new interpretation and leaving her original intention behind.

2. How does it go about achieving these aims (what specific aspects or elements help produce and shape
the experience you have of the writing)? That is to say, by what means of literary form and technique,
such as narrative, dialogue, character, poetic line, rhythm/music, tone, diction, figurative language
(metaphor, metonymy, allegory, etc.), image, grammar and syntax, etc. does the piece produce the effects
it does--what are its gears and pulleys, what is its code and are there any bugs in it?

3. What elements/choices are hindering the piece, undermining its effectiveness, or otherwise feel at odds
with the rest (in a way that doesn’t further its aims, that is unproductive, even disruptive and distracting)?

Framing our critiques/responses in this manner will be more productive in approaching the pieces than
merely saying "I like/don't like X, Y, or Z." It's easy to fall into this, and I'm sure we all will at some
point, but we need to make a concerted effort not to reduce critique merely to the polling of the audience
as to what they like, which may be beside the point for the writer, who isn't, certainly, trying to please the
group, but to better understand how her piece operates and what the range of choices might be for revising
it.

We’ll turn in work in Word and/or PDF document format on our Canvas course site. We will use the
“Track Changes” and “New Comment” functions in the MS Word Review Pane. In Adobe Acrobat
Reader, we will use the “Highlight” and “Add Sticky Note” or “Add Text” functions. In Word, you want
to select the word or phrase or punctuation mark you are commenting on, click on the Review tab, and
click the New Comment button (In the middle of the toolbar you will find a dropdown menu that will
most likely start with “Final”; you may have to choose “Final: Show Markup” to view the comment
bubbles in the right hand margin. In Acrobat Reader, select and then “highlight” in yellow the text on
which you’re commenting. Place your cursor at the end of this highlighted text or in the margin next to it
and click “Insert Sticky Note.” Type away!

NOTE: Work to be critiqued will be submitted by 11:59pm a week prior to whatever day the piece
is scheduled to be workshopped in class. So, if you are being workshopped on Tuesday, October 8, then
you need to upload a piece by 11:59pm (give or take) the night of Tuesday, October 1.

Instructions for Posting Workshop Pieces and Critiques

Each workshop will have a group folder for that week, and within that folder will be individual folders for
each member of the group. That’s where you will upload both your own piece to be workshopped and the
pieces you have closely read and critiqued for your peers. Here it is step by step:

1. Save a copy of the piece you want to workshop, naming it on this model: YourName-TitleofPiece.
For example, if 'm up for workshop and I choose my “Character Study” assignment (which I’ve
saved in my ENGL 71 Creative Writing Dropbox folder), I would save a new copy of it as
“TodEdgerton-CharacterStudy.”

2. Ithen go to our class Google drive. Let’s say I’'m in Group 2 and it’s our third workshop on Oct.
8. I go the “Group 2 Workshop 3” folder, then to my “Tod” folder within that group folder and
upload my Word doc by 11:59pm on Oct. 1—one week before workshop. I’'m done with
submitting my own piece.
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3. Then, on Wednesday, Oct. 2, everyone in class goes to that folder and downloads all of the pieces
from each person’s folder and saves them to their Dropbox or Google docs class folder. When you
save a copy, add “~YourName-Notes™ to the end of the title. In the example above, Julietta Doe
would save my piece in her ENGL 71 Dropbox folder as “TodEdgerton-CharacterStudy-Julietta-
Notes.”

4. Throughout the week, you’ll read the pieces at least once. Then you’ll go back a day or three later
and read it again, using the Word Review Pane’s “Add Comment” feature to share your analyses
and interpretations of how the story, poem, or essay is working at any given point and to narrate
your overall impressions and experience reading the piece (how did you move through it, what did
it make you think and feel, etc.). NOTE: Do not upload your finished critiques until after they
have been discussed.

5. Bring your critiqued copies of that week’s workshop pieces to class when we’re scheduled to
discuss them. All of your work should be saved both to the cloud and to your computer, so that
you can access it with or without an internet connection and will have a back-up if your computer
goes kaput. This is why I recommend using Dropbox (again, you can download it for free from
https://www.dropbox.com/. In class, we’ll share our most important points, our interpretations and
analyses of what worked well and not so well—and why or why not.

6. After class is dismissed or later that same night, upload your critiques, each one back to the folder
where you downloaded it in the first place (so my “TodE-CharacterStudy” piece in my “Tod”
folder within the “Group 2 Workshop 3” folder, to go back to our example) so that each person
can view all of everyone’s critiques, analyses, interpretations, and narrations of experiences
reading the piece to see what they can learn from us as a “test audience” for their piece when
deciding how they might want to revise and further develop it.

Important Note on Workshop Critiques: Don’t take workshop suggestions as directions. Y ou
have to decide for yourself, ultimately, what you think is best for your work. Don’t just blindly follow
others’ suggestions. Conversely, don’t blindly reject all feedback, either.

THE FINAL PORTFOLIO

will consist of two sections: the “Final Versions” and the “Earlier Versions.”

The Final Versions

section will consist in one or more polished drafts of your stories, poems, and/or essays. This section
should come to 10 pages minimum, 25 pages maximum (counting only the final versions, not earlier
revisions). The Final Version(s) section could include a single piece or several, one genre or many, but
each piece should be fully developed, and as revised, polished, proofread, and finished as possible.

Earlier Drafts

After all of the polished drafts, in a new section, in descending order from newest to oldest, should be two
to five (2-5) older versions, all in different states of revision (you can also include early “alternate
routes” you experimented with before deciding on the final form of the piece). You should choose those
pieces you feel are most accomplished and successful in meeting their aims, those pieces from which you
learned the most in the process of composition, and the pieces that show your capacity for effective
revision.
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I will be grading your portfolio on creativity, literary skill and craft, and, above all else, demonstration of
commitment and hard work in doing your very best on the pieces you revise for the portfolio (as with
your peer critiques, reading journals, and everything else expected of you for the course).

Formatting

e Your portfolio should include a title page with your name, student ID, email address, and any title
you want to give it in addition to “ENGL 71-05 Fall 2019 Final Portfolio.”

¢ You should have a separate title page for “Final Versions” (or “Version”) section and for the
“Earlier Versions” section.

e Start each new piece, including title pages, at the beginning of a new page by inserting a page
break: 1) Place the cursor in front of the first letter of the title (where you want the page to begin).
2) Click Layout > Breaks > Page Break (or Section Break > New Section)

B € O [ = ENGL 71-07 Syllabus Spring 2019-4.30 - Last saved by user e
Home Insert Draw Design Layout References Mailings Review View Help Acrobat Q Tell me what you want to do
W '/ Breaks - Indent Spacin ‘(» Align ~
il re\O pt Selection

Margins Orientation Size  Column Page

Mark the point at which one page ends Rare

L

Page Setup and the next page begins. Arrange
0 Q Column 2 3 4 5 . . 6 o
NaVIQatlon : * Indicate that the text following the column
break will begin in the next column } . . .
Search document o- Text Wrapping 1 jnclude a title page with your name, student ID, email address, and any

Separate text around objects on web
pages, such as caption text from body texy

t in addition to “ENGL 71-07 Spring 2019 Final Portfolio.”

Headings Pages Results
;parate title page for “Final Versions” (or “Version”) section and for the

AR 2011 ORI SRR

Sectidg Breaks
Classroom Protocol Next Page ction.
' he new

including title pages, at the beginning of a new page by inserting a page
wrsor in front of the first letter of the title (where you want the page to
out” >

4 PARTICIPATION is requir... section on TRETEXTTTge
Discussion Guidelines Continuous

Insert a section break and start the new

\Q Share

THE FINAL PORTFOLIO
4 University Policies

Academic integrity

section on the same page.

Even Page

Insert a section break and start the new

section on the next even-numbered page. RES

0dd Page scussions of model readings, remain respectful, but honest. Our main goals
Insert a section break and start the new

section on the next odd-numbered page. Il sensory, emotional, and intellectual experience of the work, to
articulate what we see the piece’s aims being (which may or may not line up with the author’s actual

Campus Policy in Co...

Student Technology...

e Add page numbers: Insert > Page Number

ENGL 71-07 Syllabus Spring 2019-4.30

Draw Design Layout References Mailings Review View Help Acrobat  © Toll ma what you want to do

Pictures Icons Chart Header - SR Equation - EES
= % - Eicetaddins W L @ . A = T ea
Online Pictures (] 3D Models - g, Screenshot - - : Footer - A- T Q Symbol -
. ) Wikipedia Online  Links § Comment Text Insert
Page Break Shapes - T SmartArt ® My Add-ins - Video | = |- Page Number -\ goy - = Madia
Pages Tables lllustrations Add-ins Media Comments Header & Footer Text Symbols Media
(
. . . D | . 1 . . 2 | . Co . \4 ' | Add Page Numbejs o U
Navigation S TP - o
g Enl Number the paggf in your
document,
Search document P .
_ - e Add page numbers: Insert > Page Number PO Choose from a variety of
Headings Pages Results )
—_— pre-defined looks or select your
7 | own format.
Classroom Protocol BN

@ Tell me more

University Policies

The link below contains university-wide policy information relevant to all courses, such as academic
integrity, accommodations, and so forth: http://www.sjsu.edu/gup/syllabusinfo/index.html. The First-Year
Writing Program’s policies can be found: http://www.sjsu.edu/english/frosh/program_policies/index.html.
Plagiarism and other acts of academic dishonesty will not be tolerated under any circumstances. For your
convenience, | have copied below some of the most important and/or useful.
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Academic integrity

Your commitment, as a student, to learning is evidenced by your enrollment at San Jose State
University. The University Academic Integrity Policy F15-7 requires you to be honest in all your
academic course work. Faculty members are required to report all infractions to the office of Student
Conduct and Ethical Development. Visit the Student Conduct and Ethical Development website for more
information.

Campus Policy in Compliance with the American Disabilities Act

If you need course adaptations or accommodations because of a disability, or if you need to make special
arrangements in case the building must be evacuated, please make an appointment with me as soon as
possible, or see me during office hours. Presidential Directive 97-03 requires that students with
disabilities requesting accommodations must register with the Accessible Education Center (AEC) to
establish a record of their disability.

Student Technology Resources
Computer labs and other resources for student use are available in:

o Associated Students Print & Technology Center at http://as.sjsu.edu/asptc/index.jsp on the
Student Union (East Wing 2nd floor Suite 2600)
The Spartan Floor at the King Library at http://library.sjsu.edu/about/spartan-floor
Student Computing Services at http://library.sjsu.edu/student-computing-services/student-
computing-services-center

o Computers at the Martin Luther King Library (4™ floor) for public at large at
https://www.sjpl.org/wireless

o Additional computer labs may be available in your department/college

A wide variety of audio-visual equipment is available for student checkout from Collaboration &
Academic Technology Services (http://www.sjsu.edu/at/) located in IRC Building. These items include
DV and HD digital camcorders; digital still cameras; video, slide and overhead projectors; DVD, CD, and
audiotape players; sound systems, wireless microphones, projection screens and monitors.

SJSU Peer Connections

Peer Connections’ free tutoring and mentoring is designed to assist students in the development of their full
academic potential and to inspire them to become independent learners. Peer Connections tutors are
trained to provide content-based tutoring in many lower division courses (some upper division) as well as
writing and study skills assistance. Small group and individual tutoring are available. Peer Connections
mentors are trained to provide support and resources in navigating the college experience. This support
includes assistance in learning strategies and techniques on how to be a successful student. Peer
Connections has a learning commons, desktop computers, and success workshops on a wide variety of
topics. For more information on services, hours, locations, or a list of current workshops, please visit Peer
Connections website at http://peerconnections.sjsu.edu for more information.
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SJSU Counseling and Psychological Services

The SJSU Counseling and Psychological Services is located on the corner of 7th Street and San Carlos in
the new Student Wellness Center, Room 300B. Professional psychologists, social workers, and counselors
are available to provide confidential consultations on issues of student mental health, campus climate or
psychological and academic issues on an individual, couple, or group basis. To schedule an appointment
or learn more information, visit http://www.sjsu.edu/counseling.

Schedule of READINGS and WORKSHOPS for ENGL 131: Poetry Writing*

* This outline is a provisional sketch of our semester; it is subject to change. Readings are due to be
prepared for discussion on the date listed. SEE CANVAS for full instructions and due dates for all
WRITING ASSIGNMENTS. A helpful guide to Canvas can be found here:
https://community.canvaslms.com/docs/DOC-10701. ALWAYS DEFER TO CANVAS in the case of
discrepancies. All readings other than those from the three required texts listed above will be PDF files
uploaded to Canvas.

Week 1, Mon, Jan 27: Introduction, discussion of Trethewey’s “White Lies” (prepared in advance—see
Canvas assignments and my email of 1/23)

Week 1, Wed, Jan 29: Discuss chaps. 1 and 2 of Doty, The Art of Description; Poetry Packet 1
Week 2, Mon, Feb 3: Excerpts from The Resistance to Poetry and Poetry Packet 2

Week 2, Wed, Feb 5: Why Poetry, “Introduction” and chaps 1-3 (pp. xi-40); Poetry Packet 3
Week 3, Mon, Feb 10: The Sounds of Poetry, chaps. 1 and 2; Poetry Packet 4

Week 3, Wed, Feb 12: The Sounds of Poetry, chaps. 3 and 4; Poetry Packet 5

Week 4, Mon, Feb 17: Excerpts from The Resistance to Poetry and Poetry Packet 6

Week 4, Wed, Feb 19: Workshop Group 1

Week 5, Mon, Feb 24: Workshop Group 2

Week 5, Wed, Feb 26: Workshop Group 3

Week 6, Mon, March 2: Workshop Group 4

Week 6, Wed, March 4: Workshop Group 5

Week 7, Mon, March 9: Olio, pages 1-57

Week 7, Wed, March 11: Workshop Group 1
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Week 8, Mon, March 16: John Berryman, from 77 Dream Songs (PDF on Canvas); Olio, pages 71-85
Week 8, Wed, March 18: Workshop Group 2

Week 9, Mon, March 23: Olio, pages 128-145

Week 9, Wed, March 25: Workshop Group 3

Week 10, Monday, March 30 through Friday, April 3: SPRING BREAK

Week 11, Mon, April 6: Olio, pages 155-207

Week 11, Wed, April 8: Workshop Group 4

Week 12, Mon, April 13: Poetry Packet 4 (PDF file with writing assignment on Canvas)
Week 12, Wed, April 15: Workshop Group 5

Week 13, Mon, April 20: Final Portfolio Workshops

Week 13, Wed, April 22: Final Portfolio Workshops

Week 14, Mon, April 27: Final Portfolio Workshops

Week 14, Wed, April 29: Final Portfolio Workshops

Week 15, Mon, May 4: Final Portfolio Workshops

Week 15, Wed, May 6: Final Portfolio Workshops

Week 16, Mon, May 11: Final Portfolio Workshops—LAST CLASS MEETING

Week 17, Mon, May 17: FINAL PORTFOLIOS DUE ON CANVAS

Important Dates

For important university-wide dates and deadlines, see the San José State University Spring 2020
Academic Calendar online. Here are some highlights.

Tuesday ......ccccceieennnn. February 4 ............... Last Day to Drop Without “W” on Transcript
Tuesday .........ceeeevenns February 11 ............. Last Day to Add Courses & Register Late
Wednesday.................... February 19............... Enrolliment Census Date

Monday - Friday ............ March 30-April 3 ..... Spring Recess

Tuesday ......cccceiennnnn. March 31 ................... Cesar Chavez Day (Obs.) - Campus Closed
Monday .........cccceeeeeeeen. May 11 ... Last Day of Classes

Tuesday ......ccccceieennnn. May12 ...................... Study/Conference Day (no classes or exams)
Wednesday - Friday...... May 13-15......ccovvnnnnees Final Examinations
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Monday - Tuesday ........ May 18-19.................. Final Examinations

Wednesday.................... May 20 .....cccoeevveeennnn. Final Examinations Make-Up Day

Friday ...ooovvvviiiin. May22 ...................... Grades Posted by Faculty by 11:59pm
Friday ....oooovvvviniiiinn, May 22 ..., End of Spring Semester/Academic Year
Wednesday - Friday....... May 20-22.................. Commencement
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